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Introduction

@ Adobe Captivate® is designed to help you create instructional videos, also called screen casts.
This booklet explains how to create an Adobe Captivate project with accessibility.

Learning Objectives

After completing the instructions in this booklet, you will be able to:

Enable accessibility

Add accessibility to multiple area to a project
Setup shortcut keys for buttons

Add text for slide notes

Convert the slide notes for closed captioning
Convert the slide notes to text-to-speech
Configure the play bar to enable Closed Captioning

Revised 4/25/2016
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Enable Accessibility

@ The project has to have accessibility enabled for any accessibility options to work in captivate and
with accessibility technology. The following explains how to enable accessibility.
1. On the menu bar, click Edit.
From the Edit menu drop-down, click Preferences.
From the Preferences dialog box, click Publish Settings (See Figure 1).
Check the box Enable Accessibility (See Figure 1).
Click the OK button (See Figure 1).

Preferences

vk wnw

Category Project: Publish Settings
General Settings
Frames Per Second: | 30
Defaults
¥ Recording [C] Publish Adobe Connect metadata.
Settings

Include M
Video Dema [ Include Mouse

Keys - (Global) @EEnahleAccessihility |

D [C] Restrict keyboard tabbing to slide items only

Defaults

. [ Hide selection rectangle for slide items in HTMLS
w Project

information [ Include Audio

Size and Quality [ Publish Audio as Mono

Publish Settings o‘ [ Play tap audio for recorded typing

Start and End
¥ Quiz Externalize Resources: [ Skin

Reporting [ widgets

Settings [] FMR SWF

Pass or Fail s

Default Labels

Styles Preview

Figure 1 - Enable Accessibility

Project Information

@ Adding this information will provide the necessary information for the project and help those with
screen readers.

1. On the menu bar, click Edit.

2. From the Edit menu drop-down, click Preferences.
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3. From the Preferences dialog box, click Information (See Figure 2).

4. From the Preferences dialog box, enter the following information (See Figure 2).
a. Author - The department creating the captivate project.

Company - Kennesaw State University.

E-mail - E-mail address of the department or customer service desk.

Website - www.kennesaw.edu

Copyright - © 2016 Kennesaw State University. All Rights Reserved.

o

Project Name - The name of your captivate project.
g. Description - A description of your captivate project.
5. Click the OK button (See Figure 2)

Category Project: Information
General Settings
. (4 | author:| University Information Technology Services {a ,
Defaults ot
» Recording | company: | Kennesaw State University {b
Settings | E-mail: | something@kennesaw.edu {c l.
Video Demo
Keys - (Global) | website:| www kennesaw.edu {d
i | copyright:| © 2016 Kennesaw State University. All Rights Reserved. (e
Defaults
v Project | Project Name: | Accessibility Training (f
ol Description: | This captivate project will help setup accessibility. -
Size and Quality
Publish Settings
Start and End —
w Quiz
Reporting Time: 3.0secs (30 frames)
Settings

Resolution: 1024 x 627
Pass or Fail

Default Labels Slides: 1

Hidden Slides: 0

Styles Preview

Figure 2 - Project Information
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Slide Label

1. On the Filmstrip, click a slide (See Figure 3).

On the toolbar, click Properties (See Figure 3).

In the Properties panel, click Properties (See Figure 3).
Type a Slide Label name (See Figure 3).

P wNnN

File Edit Wiew Insert Quiz Audic Videc Themes Window

O“ @' “ cu)o" E"'

Slides Themes Text Objects

Modify  Project

Shapes Interactions Media Recard Save Preview

Publishssets
3

Properties

FILMSTRIP untitledl.cpbc™ = |

4 PROPERTIES

e o

Welcome 1o Captivate Accessibility

KENNESAW
. STATE [JNIVERSITY

Welcome to Captivate Accessibility

-

n I‘ Welcome

Master Slide

Title

Reset Master Slide
Master slide view

=T

[ Allow Gesture Navigation

Actions Options |

Background

‘ Master Slide Background

Quality

Button_2
Button_1
Image_3
Title_AutoShape_1

K5U Mountain Logo:3.0s

Weloms 1o Captivate Accessibility :Display ...
Shide (3.05)

Welcome

untitled1.cpbe®

Figure 3 - Slide Label Name

‘ Optimized

[C] Master Slide Objects On Top

Filmstrip View 1024 x 627
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Slide Accessibility

1. On the Filmstrip, click a slide (See Figure 4).

2. Onthe toolbar, click Properties (See Figure 4).

3. In the Properties panel, click Properties (See Figure 4).
4. Click the Accessibility button (See Figure 4).

5. Click Accessibility (See Figure 4).

- 2 )
® @ |0 8 B | - & B ® L & E=] =
Slides Themes Text Shapes Objects Interactions Media Record Save Preview Pub\ismssets Library Properties

FILMSTRIP untitled1.cpbe™ *| 4 PROPERTIES I TIMIN|
=Y 4
NS Welcome =
ey € - OL
R KENNESAW 5 ) Accessibility...

~ STATE UNIVERSITY B

@

— Title

Welcome to Captivate Accessibility

Hext ¥ Allow Gesture Navigation -
Backaground
‘ Master Slide Background v |
14 il
! J Quality
TIMELINE ‘ |
7 m I Optimized v
oa P70, TR
Bl Button_2 ® Active: 1.55 11| Inactive: 155 [] Master Slide Objects On Top
BB Next_Button e @ Active; 1.55 1| Inective: 235
[ KsU_Image & @ K5U Mountain Logo:3.0s
Title_AutoShape_1 s e Wigkome to Captivate Accessibility :Display for the rest of the siide
O welcome e o Slide (5.25)

bl (E gos b -

- @52

Figure 4 - Slide Accessibility Button

6. From the Slide Accessibility dialog box, type a description (See Figure 5).
Note: If you have Slide Notes in your captivate project, you can import them.
7. Click the OK button (See Figure 5).

Type in slide accessibility description here.

Cancel

Figure 5 - Slide Accessibility Description
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Slide Tab Order

@ The tab order of the interactive objects will set the order in which objects are read by a screen
reader.
1. On the Filmstrip, click a slide (See Figure 6).
On the toolbar, click Properties (See Figure 6).
In the Properties panel, click Properties (See Figure 6).
Click the Accessibility button (See Figure 6).
Click Tab Order (See Figure 6).

vk wnw

File Edit WView Insert Modify Project Quiz Audic Video Themes Window Help

® O | T % E| w- & & ® L & =

slides Themes Te Shapes Objects Interactions Media Record Preview Puhllsmssets Properties

FILMSTRIP untitled1.cpbe* *| 7’ PROPERTIES
=
_/\
T e

Welcame to Captivate Accessibility

Tab Order...

KENNESAW A o
< STATE [JNIVERSITY -

Welcome to Captivate Accessibility
I

| Actions Options |

[ Allow Gesture Navigation

Background

‘ Master Slide Background

Quality

TIMELINE
000 |oo=u1 [ I [ ‘ Optimized
[N L

Button_2 Active; 1,55 1 five: 1. ] Master Slide Objects On Top

MNext_Button Active: 1,55 1

KSU_Image KSU Mountain Logo:3.0s

Title_AutaShape_1 Welome to Captivate Accassibility :Display for the rest of the slid
Welcome Shide (5.25)

)

C:\Users\rdean21\Desktopluntitled1.cpbe Filmstrip View 1024 x 62

Figure 6 - Slide Accessibility Button
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6. From the Tab Order dialog box, click a Component (See Figure 7).

Note: If you don’t have any interactive objects on the slide you won’t have anything to arrange in

the Component list.

7. To change the Tab Order of the selected Component, click the Move Selected Row Down or
Move Selected Row Up (See Figure 7).

8. Repeat steps 6 through 7 for the rest of the Components.

9. Click the OK button (See Figure 7).

Place the components in the order in which youwant a screen
reader andfor a keyboard to navigate through them.

Component @ ¥+ 4
Button_1

Button 2

Figure 7 - Tab Order Arrangement

Page 10 of 24



Object Label

@ Objects are the items on each slide.

On the Filmstrip, click a slide (See Figure 8).

On the slide, click an object (See Figure 8).

On the toolbar, click Properties (See Figure 8).

In the Properties panel, click Properties (See Figure 8).
Type an Object Label name (See Figure 8).

vk wN e

File Edit WView Insert Modify Project Quiz Audic Video Themes Window Help Best Fit

3 | 2
» —
® O | 25 F-| - - 8 ® G & =
oo -4 —
slides Themes Text Shapes Objects Interactions Media Record Preview Puhllsmssets Properties

FILMSTRIP untitledl.cptx™®  x | @ 4 PROPERTIES
A< )

BN : 3 ® K5U_Image
S~ | |

KENNESAW

Welcome to Capivate Accessibility

, STATE [JNIVERSITY

-

Object State

| Normal (Default) v | g

State View

[C] Retain State on Slide Revisit

| @ K5U Mountain Logo.png

Welcome to Captivate Accessibility

l—_I/: |/-/:| | Reset To Original Size

Edit Image
n Fit to Stage

TIMELINE
) |00:01
[

¥ Shadow and Reflection

Button_2 Active: 1.55
= Il Shadow

Button_1 Active: 1.5 ]

#) None () Inner () Outer
Image 3 KSU Mountzin Loge:3.0s

Title_AutoShape_1 Vigloms 1o Captivate Accessibilty :Display .. Reflection

Welcome Shide (3.05) =
|

P oFl 4 E 0o Hoos Biaos W30
untitledL.cpbe | Filmstrip View | X: 1027 Y: 87

Figure 8 - Object Label Name

Page 11 of 24



Object Accessibility

On the Filmstrip, click a slide (See Figure 9).
On the slide, click an object (See Figure 9).
On the toolbar, click Properties (See Figure 9).

o vk wnN

9.

In the Properties panel, click Properties (See Figure 9).

Click the Accessibility button (See Figure 9).
Click Accessibility (See Figure 9).

File Edit

Insert  Modify

Project Quiz Audio Video Themes Window

O' @” “ go” E’“

Slides Themes

Text Shapes

Objects Interactions Media Record

Pubhsmssets

| BestFi

FILMSTRIP

e

STATE UNIVERSITY = |

WelCome 1o CRpLvaLe ACcessibility

untidledl.cpbx® = |

4 PROPERTIES

KENNESAW
“—— STATE [JNIVERSITY

-

Welcome to Captivate Accessibility

i

i

TIMELINE

B Guton 2

j0:00 |00:01 |00:02
| |

Actives 1,55 11| Inective: 1.55

Bl Next_Button

Active: 1.5 11| nactive: 2.35

[ KSU_Image

KSU Mountain Logo:3.0s

Title_AutoShape_1

Wekome to Captivate Accessibility :Display for the rest of the shds

E welcome

Sice (5.25)

s\rdean21\Desktop\untitled1.cpix

P P4 E g0 b oos bizes sz

Figure 9 - Object Accessibility Button

Normal (Default) v o
State View

[] Retain State on Slide Revisit

Properties

| [®9] KSU Mountain Logo.png

[Fak ‘/»’:‘ | Reset To Original Size

Edit Image
Fit to Stage

¥ Shadow and Reflection

Shadow

+) None () Tnner () Outer

Reflection

| Fimstrip view | 1024 x 627

From the Item Accessibility dialog box, un-check Auto Label (See Figure 10).

Type an Accessibility Name (See Figure 10)
Type an Accessibility Description (See Figure 10).

10. Click the OK button (See Figure 10).

= ]

Accessibility Name:| Kennesaw State University Logo

Accessibility Description:]| Offidal logo for Kennesaw State

University

Crewa( 7)

Note: If Auto Label is checked, then the accessibility name and
description are auto-generated in the SWF published output.

10

Help... OK

Figure 10 - Object Accessibility Name & Description
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Keyboard Shortcut

@ Shortcut keys provide a quicker way to navigate using the keyboard.
1. On the Filmstrip, click a slide (See Figure 11).
2. Onthe slide, click an interactive object (See Figure 11).
Note: An interactive object is an item you are able interact with (e.g. Button).
3. Onthe toolbar, click Properties (See Figure 11).
4. Inthe Properties panel, click Properties (See Figure 11).
5. Click the Actions tab (See Figure 11).
6. Apply a keyboard Shortcut (See Figure 11).

= 3
® & | O 2B Bl - & & B O L& =] =
Slides Themes Text Shapes Objects Interactions Media Recard Save Preview Publismssets Library Properties

FILMSTRIP untited1.cptx™ = 4 PROPERTIES I TIMING

-

|
¥ _{&“ﬁgﬂ%\ . ® |Next_Butbon |
Welcome 1o Captwate Arcessibility Object State =
i KENNES‘AW | Normal (Default) -| +
. STATE UNIVERSITY -,

State View

e AR [] Retain State on Slide Revisit
Welcome to Captivate Accessibility W
Style Name =
—— | [Default Text Button Style] v |

] Replace modified styles
| Style Options |

.| OnSuccess:
< [ 1l 3 | Go to the next slide "
TIMELINE
E [ [ Infinite Attempts
® a " ‘ |nn 01 |nn 0z | i} D
B Button_2 s = Active; 1.55 Il| Inactive: L5s 4 | No.of Attempts:
@ Button_1 = e Active: 1.55 Inactiva: 155 [ Allow Mouse Click
[®] Image 3 s = KSU Mountzin Loge:3.0s chortaut:
Title_AutoShape_1 s @ Welcoma to Captivate Accessibility :Display ... -
B Welcome s ® Shide (3.05) 6
) Ctrl () shift () None
PP oo Hoos B30 W30 e 1 » .

Figure 11 - Keyboard Shortcut
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Slide Notes

@ You can add slide notes to each slide and be able to use those for closed captioning, text-to-
speech, and as a transcript when recording your audio.

Adding Notes
1. On the menu bar, click Window.
From the Window menu drop-down, click Slide Notes.
On the Filmstrip, click a slide (See Figure 12).
In the Slide Notes panel, click the Plus (+) button (See Figure 12).
Type the Note (See Figure 12)

o vk wnN

Repeat steps 3 through 5 for the rest of the notes.

File Edit View Insert Modify Project Quiz Audio \Video elp g | Best Fit

®- <~ | [ 8o [l & =

Slides Themes Text Shapes Objects Interactions Media Recard Save Preview Publish Assets Library Properties

FILMSTRIF untited1.cptx™ = | PROPERTIES TIMING

Ko I 0 ] | welcome
ity €
- KENNESAW
<~ STATE UUNIVERSITY -,

Title

Reset Master Slide
Master slide view

[ Allow Gesture Navigation

Welcome to Captivate Accessibility

Background

‘ Master Slide Background

SLIDE NOTES TIMELINE Quality
4 ‘ Optimized
B ‘ 5 ' Text-to-Speech™ Closed Captioning |Filter | Notes " +
g

_|T [] Master Slide Objects On Top
accessibility

v |

untitled1.cpbe® Filmstrip View X: 1024 Y: 116

Figure 12 - Adding Slide Notes
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Removing Notes
1. Onthe Filmstrip, click a slide (See Figure 13).
2. In the Slide Notes panel, click the Note (See Figure 13).
3. Click the Minus (-) button (See Figure 13).

File Edit Wiew Inseit Modify Project Quiz  Audioc Video Themes Best Fit

® &- | @+ 25 [ L & G =

slides Themes Shapes Objects Interactions Media Record Save Preview Publish Aszets Library Properties

FILMSTRIP untittedl.cptx™® =

P o

STATE UNIVERSITY ]

Welcome to Captivate Accessibility

PROPERTIES TIMING

n ‘ Welcome

Master Slide

|
KENNESAW
. STATE [JNIVERSITY

®

Title

Welcome to Captivate Accessibility 1

[ Allow Gesture Navigation

Background

- ‘ Master Slide Background

[ I 2

ality

,3):timized
= -
‘ +QT:I Master Slide Objects On Tap

SLIDE NOTES TIMELINE

for Kennesaw State University

untitled1.cpbe® Filmstrip View 1024 x 627

Figure 13 - Removing Slide Notes

Closed Captioning

@ If you have audio in your captivate project, you can have text displayed when the audio plays.
Adding Captions

1. Onthe menu bar, click Window.
2. From the Window menu drop-down, click Slide Notes.
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3. On the Filmstrip, click a slide (See Figure 14).

4,
Note: You need to have an audio file on the slide to be able to enable the Closed Captioning.

e Edit

®- &@- O

Slides Themes Text

o v
oo
Shapes

In the Slide Notes panel, check the Closed Captioning check-box (See Figure 14).

1

B 9 B & B S

Objects Interactions Media Record Save Preview Publish Assets

Library  Properties

FILMSTRIP

untitied1.cpte® =

LIBRARY

Srart NV RS

< STATE UNIVERSITY

» | untitled L.cptx - 5 items in library
No Preview available.
1=
Welcome to Captivate Accessibility Im & 2
Name | Size(KB) | Use C... | St... | Date!
v ¥ Audio
) Text to Aud... 46296 1 Fridg
v 'Fn Backgrounds
BxEvious, | abient; [ 8G.pg 19988 1 wed
7T Equations
_|¥ ® mages
;

\
KENNESAW

T - [®] clipboard... 241 0 Wed

SLDENOTES —— [E Clipboard.. 241 0 wed
[F KsU Moun... 2786 1 Thur:
My O% Text-to-Speech™ | [ Closed Captioning | Filter [ Notes <] v '@ Media
5] T4 TE Video
Welcorfe to cagtivate accessibility [ Presentations
[ l % Shared Actions
for University

untitled?.cpbe™

Filmstrip View | 1024x 627

Figure 14 - Adding Closed Captioning

Adjusting Caption Display Time

1.

2.
3.
4

slides Themes Text

Shapes

On the menu bar, click Window.

From the Window menu drop-down, click Slide Notes.

On the Filmstrip, click a slide (See Figure 15).

In the Slide Notes panel, click the Closed Captioning button (See Figure 15).

Window 2 om g

Fl- e & &8 B e L& & =

Objects Interactions Media Record save Preview Publish Assets Library  Properties

Help 1 / 2 | BestFit

FILMSTRIP

untitled1.cpbc™  * ‘ LIBRARY

KENNESAW

& | untitled1.cpbe- 5 items in library
No Preview available.
&
Welcome to Captivate Accessibility =5 @
Name 4 Size{KB) | Use C.. | St.. Date
v "% Audio
) Textto Aud... 462.96 1 Fridg
v ' Backgrounds
Brevine, |waex ™ BG4pg 19988 1 Wed
7T Equations
<~ " Images
»

STATE UNIVERSITY

T = ] ¥ clipboard. 241 0 wed

TS | P [® clipboard... 241 0 Wed
{ 4 ] KSU Moun... 27.86 1 Thurs
B+ O% Text-to-speech® | Closad cantmmng\ﬂgr\ Notes - + v 0 Media
[&1O] B T8 video
Welcome to captivate accessibility [ Presentations
& O] I % Shared Actions

for Kennesaw State University

untitled1.cpbe

Filmstrip View | 1024x 627

Figure 15 - Closed Captioning
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5. Inthe Slide Audio dialog box under the Closed Captioning tab, in the audio timeline find the
caption marker you want to adjust.

 Slide Audio

ace | Edit | Cclosed Captioning

Record Zoom

’ = 50

Name : Recordingl.wav

‘00:00:00 00:00:01
! T

Narration : Recordingliway
T

Duration: 00:00:03 | Playhead: 00:00:00 | Selected: 00:00:00

Figure 16 - Caption Marker

6. Left-Click and Hold the caption marker.

Shde Audic

ace " Edit | Closed Captioning

Record Zoom

’ —C—= 50

Name : Recordingl.wav

‘00:00:00
I T |

Narration : Recordingl.wav

1 3
Duration: 00:00:03 | Playhead: 00:00:00 | Selected: 00:00:00

Figure 17 - Move Caption Marker

7. Drag the caption marker to the desired location.
8. Let go of the Left-Click.

=
Slide Audic

= | Edit | closed Captioning

Record Zoom

’ = 50

Name : Recordingl.wav

‘00:00:00 00:00:01 |00:00:02 |00:00:03
P R S NI T L T P T T SO T R T P
Narration : Recordingl.way
] »

Duration: 00:00:03 | Playhead: 00:00:00 | Selected: 00:00:00

Figure 18 - Drop Caption Marker

9. Click the Save button.
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Removing Captions
1. Onthe Filmstrip, click a slide (See Figure 19).
2. In the Slide Notes panel, un-check the Closed Captioning check-box (See Figure 19).

File Edit View Insert Modify Proje Quiz  Audic \Video Themes Window

O“ @' “ cu)o" E"'
Text

Slides Themes Shapes Objects Interactions Media Recard Save Preview Publish Assets Library Properties

FILMSTRIF untittedl.cpix® = | LIBRARY

untitledi.cpte- 5 items in library

ey
e U o

Welcome 1o Captivate Accessibility

KENNESAW
“— STATE [UNIVERSITY

No Preview available.

Welcome to Captivate Accessibility ICE @

Name & Size(KB) UseC.. | St.
¥ 4 Audio
) Text to Aud.. 462.95 1
w 'Fn Backgrounds
" BG.jpg 199.88 1
JT Equations

" Images
[ clipboard...
[ clipboard...
[F KSU Moun...
Text-to-Speech® || Closed Captioning | Filter | Notes © Media
5 video
‘Welconjeto captivate accessibility Ll Presentations
|:| |:| | # Shared Actions
fork ate University WG
e Web

TIMELINE

untitled1.cpbe® Filmstrip View 1024 x 627

Figure 19 - Removing Captions

Text-to-Speech

@ Use Text-to-Speech to generate an audio file of the slide notes. All slide notes are generated into
a single audio file.

Adding Text-to-Speech

1. Onthe menu bar, click Window.
2. From the Window menu drop-down, click Slide Notes.
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3. On the Filmstrip, click a slide (See Figure 20).
4. Inthe Slide Notes panel, check the Text-to-Speech check-box (See Figure 20).

5. Click the Text-to-Speech button (See Figure 20).

Insert Project Quiz  Audic Video Themes elp ! 3 | Best Fit

0
[T
Text

Modify

go~ [E)-

Objects

File Edit View

®- -

Themes

slides Shapes Interactions Media Record Save Preview Publish Aszets

Library Properties

FILMSTRIP untittedl.cptx™® = |

LIERARY

_/ \
P e T

Welcame to Captivate Accessibility

KENNESAW
< STATE UNIVERSITY

untitled1.cpbe - 5 items in library

No Preview available.

>
R

Welcome to Captivate Accessibility ILE

Name

- | Size(KB) | Use C... | St...

v 4 Audio

¥ 'F Backgrounds
I BG.ipg

) Textto Aud.. 462.96 1

199.88 1

JT Equations

K" Images
[ clipboard...
¥ clipboard...

SLIDE NOTES TIMELINE

[ Ksu Moun...

=y

)
IText-tD-Speech‘Msed Captioning |Filter | Notes

v [O&
Welcometo captjvate aqeessibility

~ [O=

for Kennesaw Stisassmid erzity

0 Media
'ﬁ Video
[l Presentations
#i Shared Actions
SVG
% Web

untitled L.opbe®

Figure 20 - Adding Text-to-Speech

Filmstrip View 1024 x 627

6. From the Speech Management dialog box, click the Generate Audio button.

Speech Agent | Microsoft Anna - English (United States) - +

v Welcome

-
Welcome to captivate accessibility

v
for Kennesaw State University

Microsoft A...

Microsoft A...

Generate Audio

Help...

Figure 21 - Generate Audio
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Changing the Speech Agent
1. Onthe Filmstrip, click a slide.
2. Inthe Slide Notes panel, click the Text-to-Speech button.
3. From the Speech Management dialog box, click a Caption.

Note: To select multiple captions at the same time, hold down the Ctrl button on the keyboard

while clicking each caption.

Speech Agent | Microsoft Anna - English (United States) + —

h 4 Welcome

- Microsoft A...
Welcome to captivate accessibility

- Microsoft A...
for Kennesaw State University

Figure 22 - Text-to-Speech Captions

4. Click the Speech Agent drop-down (See Figure 23).
5. From the Speech Agent drop-down, click a Name (See Figure 23).

Note: The Microsoft Anna — English (United States) is installed by default. To be able to select other
Speech Agents you must install them. To install other Speech Agents go to the UITS Documentation

Center and search for Adobe Captivate 9 NeoSpeech.

Microsoft Anna - English (United States) 'I b

v Microsoft Anna - English (United States)

Bridget Microsoft A..

Welcome Chloe

L James Microsoft A...

for
' 5 Julie

Kate
Paul

Yumi

Generate Audio

Help...

Figure 23 - Speech Agent
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6. Click the Generate Audio button.

Speech Agent [ Julie

¥ Welcome

v

L

Welcome to captivate accessibility

for Kennesaw State University

Generate Audio

Help...

Figure 24 - Generate Audio

Removing Text-to-Speech
1. Onthe Filmstrip, click a slide (See Figure 25).
2. Inthe Slide Notes panel, un-check the Text-to-Speech check-box (See Figure 25).
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Figure 25 - Removing Text-to-Speech
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Play Bar Closed Caption

@ The closed caption button on the play bar is disabled by default. You must enable it before this
feature can be used. You can also change how the closed captioning is displayed when turned on.

Enable Closed Captioning
1. Onthe menu bar, click Project.
2. From the Project menu drop-down, click Skin Editor.
3. From the Skin Editor dialog box, check the Closed Captioning check-box.

SKIN EDITOR

Skin Editor - untitled1.cptx

Skin: [ Theme Default Mo.. ~| @ &

Qo]

[V Show Playback Control

[C] Hide Playbar in Quiz

KENNESAW
~_ STATE UNIVERSITY

Playbar: | cpPlaybarMobile v

[T] Playbar Two Rows

2 Ployback Color Welcome to Captivate Accessibility
Background: B Button Face:

Button Glow: B Button Icon: G

Position: | Bottom v |

| - [uBreions,) [ et
EEOIE ] e ched x|
[V Play ¥ Mute
[V Rewind [V Fast Forward
b Forsiand M Progress Bar > (IR o[ x]
¥ Close  Settings...

Alpha: 100 %

[C]No Tooltips at runtime

Figure 26 - Skin Editor Closed Captioning
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Configure Closed Captioning
1. Onthe menu bar, click Project.
2. From the Project menu drop-down, click Skin Editor.
3. From the Skin Editor dialog box, click the Settings button.

SKIN EDITOR

Skin Editor - untitled1.cptx

skin: [ Theme Default (Mo... ~| B &

ojo]

| e || |

S KENNESAW
~—— STATE UNIVERSITY -,

-Theme -

Playbar: ‘ cpPlaybarMobile v

[C] Playbar Two Rows

7 loyback Colors Welcome to Captivate Accessibility
Background: D Button Face:

Button Glow: G Button Icon: G

Position: | Bottom v | e e
Layout: [ Stretched = DSV | ]

M Play M Mute

[V Rewind [V Fast Forward

W Fomiard [ Progress Bar S 1 e -1
¥ Back M closed Captioning

Alpha: 100 %

[C]No Tooltips at runtime

T

Figure 27 - Skin Editor Closed Captioning Settings
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6. From the CC Project Settings dialog box, you can change the following (See Figure 28).
a. Lines - Choose how may lines of text to display at once.

Background - Change background color or transparency behind the text.

Family - Choose the font.

o0 o

Size - Choose the font size.
e. Color - Choose the font color.
7. Click the OK button (See Figure 28)

CC Project Settings

General:

@ Lines: 3 Background: @

Font Settings:

(C) Famil:

Figure 28 - CC Project Settings

Additional Help

For additional support, please contact the KSU Service Desk:

KSU Service Desk for Faculty & Staff

e Phone: 470-578-6999
e Email: service@kennesaw.edu
e Website: http://uits.kennesaw.edu

KSU Student Helpdesk

e Phone: 470-578-3555
e Email: studenthelpdesk@kennesaw.edu
e Website: http://uits.kennesaw.edu
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